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Notices

Trademarks
AJA® and Because it matters.® are registered trademarks of AJA Video Systems, Inc. 
for use with most AJA products. AJA™ is a trademark of AJA Video Systems, Inc. for 
use with recorder, router, software and camera products. Because it matters.™ is a 
trademark of AJA Video Systems, Inc. for use with camera products.

CION®, Corvid Ultra®, lo®, Ki Pro®, KONA®, KUMO®, ROI® and T-Tap® are registered 
trademarks of AJA Video Systems, Inc. 

AJA Control Room™, KiStor™, Science of the Beautiful™, TruScale™, TruZoom™, 
V2Analog™ and V2Digital™ are trademarks of AJA Video Systems, Inc.

All other trademarks are the property of their respective owners.

Copyright
Copyright © 2019 AJA Video Systems, Inc. All rights reserved. All information in 
this manual is subject to change without notice. No part of the document may be 
reproduced or transmitted in any form, or by any means, electronic or mechanical, 
including photocopying or recording, without the express written permission of AJA 
Video Systems, Inc.

Contacting AJA Support
When calling for support, have all information at hand prior to calling. To contact AJA 
for sales or support, use any of the following methods:

Telephone +1.530.271.3190

FAX +1.530.271.3140

Web https://www.aja.com

Support Email support@aja.com

Sales Email sales@aja.com

https://www.aja.com
mailto:support%40aja.com?subject=
mailto:sales%40aja.com?subject=
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Chapter 1 – AJA and Apple Overview

Apple Applications Supported
AJA hardware is tightly integrated for video and audio workflows with the 
following Apple application:

• Final Cut Pro X (video and audio)

This manual does not provide operational information for Apple applications 
except as related to AJA hardware and software operations. Please read the Apple 
user documentation for Apple application configuration and operation.

NOTE: AJA recommends using the latest AJA software in combination with the current 
version of Apple applications. For demanding workflows, AJA also recommends 
using the latest OS with up to date high performance host system hardware.

macOS Support
AJA's Io and KONA devices running Desktop Software v15.5 support macOS 
Catalina (v10.15) and Metal GPU functionality.

Hardware Products Supported
AJA in association with Apple provides a range of hardware that supports Apple 
applications courtesy of installing the AJA desktop software package:

• Io 4K Plus, Io IP, Io 4K, Io XT, Io Express
• KONA 5, KONA 4, KONA IP, KONA 1, KONA LHi, KONA LHe Plus
• T-TAP

AJA desktop software installer, and associated Apple compatibilities are also 
available with:

• Avid Artist | DNxIV
• Avid Artist | DNxIP

Other AJA products may support Apple applications in the  future. In this manual 
all supported hardware devices are referred to as "AJA hardware".

All features described in this manual may not be available with all AJA hardware. 
For example, the Audio Mixer functionality introduced to AJA Control Panel with 
AJA Desktop Software v14.0, is only available when running Io 4K Plus, Io 4K, 
KONA 4, and KONA IP. The Audio Mixer enables access to all audio inputs available 
on the AJA device.

See Table 1 and Table 2 for more details.
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Table 1.  AJA Hardware Feature Summary, Thunderbolt Devices

Io 4K Plus Io IP Io 
4K

Io 
XT T-TAP Avid Artist 

DNxIV

Avid 
Artist 
DNxIP

Tbolt Ports Tbolt 3 Tbolt 3 Tbolt 2 Tbolt 1 Tbolt 1 Tbolt 3 Tbolt 3

Max Input  
Resolution 

4K 4K 4K 2K 4K 4K

Max Output  
Resolution

4K 4K 4K 2K 2K 4K 4K

SDI In 12G/6G/3G 3G 3G 3G 12G/6G/3G

SDI Out 12G/6G/3G 3G (monitor) 3G 3G 3G 12G/6G/3G

HDMI In 2.0 1.4 1.3 2.0

HDMI Out 2.0 2.0 1.4b 1.4 1.3 2.0 2.0

HDR √ √ √ √ √

Closed 
Captions

√ √ √ √ √

SMPTE 2022-6 
(10GbE)

√ √

SMPTE 2022-7 
(10GbE)

√ √

IP Video In/Out √ √

IP Audio in/Out √ √

Analog  
Video In

Analog  
Video Out

√

Analog  
Audio In

√ √ √ √

Analog  
Audio Out

√ √ √ √ √ √

Control Panel 
Audio Mixer

√ √ √ √ √

XLR Mic Input √ √

√ = Supported         (blank) = Unsupported
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Table 2.  AJA Hardware Feature Summary, PCIe Devices

KONA 
5 KONA 4 KONA 

IP
KONA 

1
KONA 
HDMI

KONA 
LHi

KONA 
LHe 
Plus

Io 
Express

PCIe 3.0  
8-lane 

2.0  
8-lane 

2.0  
8-lane 

2.0  
2-lane

2.0  
8-lane

1.0  
4-lane

1.0  
4-lane

1.0 
1-lanes

Max Input  
Resolution 

8K 4K 4K 2K 4K 2K HD HD

Max Output  
Resolution

8K 4K 4K 2K 2K HD HD

SDI In 12G/6G/3G 3G 3G 3G 1.5G 1.5G

SDI Out 12G/6G/3G 3G 3G 3G 1.5G 1.5G

HDMI In 1.3 2.0/1.4b 1.3 1.3

HDMI Out 2.0 1.4b 1.4 1.3 1.3 1.3

HDR √ √ √

Closed 
Captions

√ √ s2022 
only

SMPTE 2022-6 
(10GbE)

√

SMPTE 2022-7 
(10GbE)

√

SMPTE 2022-7 
(10GbE)

√

IP Video In/Out √

IP Audio in/Out √

Analog  
Video In

√ √

Analog  
Video Out

 √ √ √ √

Analog  
Audio In

√ √

Analog  
Audio Out

with K3G 
box

√ √ √

Control Panel 
Audio Mixer

4K Mode 4K Mode √ √

XLR Mic Input

 √ = Supported         (blank) = Unsupported
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Chapter 2 – AJA and Apple Installation

Installing AJA Software

Download
Go to the AJA website and download the latest AJA Desktop Software package  
containing the AJA Control Panel application, other related applications, drivers 
and plug-ins. 

https://www.aja.com/en/support/downloads/

System software updates may occasionally become available for AJA products 
on our website (www.aja.com). We recommend checking occasionally for both 
software updates and additional product information.

NOTE: If your computer has previously had another video capture or multimedia device 
installed, ensure you uninstall any related software before installing the AJA 
Desktop Software package.  This will prevent any hardware or software conflicts. 

IMPORTANT:   Please read the brief Release Notes PDF file that accompanies your AJA 
software. The Release Notes describe important features and fixes.  

AJA Desktop Software Installation and Re-installation
NOTE: Always uninstall previous versions of AJA software before updating your 

computer with new software. Go to your AJA Utilities (on the Mac) or Windows 
Control Panel to uninstall existing AJA software. This helps prevent hardware/
software conflicts.

Before installing the AJA Desktop Software package, ensure that your video and 
audio editing applications are installed as detailed in its user documentation. You 
cannot use AJA hardware with a third-party application until the application has 
been installed and run at least once on your workstation. 

IMPORTANT:   If you install or update a supported Apple application at a later date, you 
must run the AJA installer program again.

AJA Desktop Software Package Components

Mac Software Package

Drivers

AJA device drivers allow tightly integrated hardware/software operation.

AJA Control Panel

The AJA Control Panel application provides:
• Source selection and control of your AJA hardware.
• A block diagram to show visually what routing and processing is being 

performed.
• AJA hardware firmware update.

https://www.aja.com/en/support/downloads/
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AJA Control Room

AJA Control Room is a software application for ingest, playback and output with 
AJA products.

AJA System Test

System Test provides accurate and detailed evaluations of drive and PCIe 
performance statistics, allowing you to measure the capabilities of your system 
for recording and playing back of various resolutions and codecs.

3rd-Party Plugins

AJA provided plugins for popular 3rd-party Professional Video Applications from 
Adobe, Avid, Apple, Telestream, and others.

NMOS Support

AJA IP capable devices support Networked Media Open Specifications (NMOS), 
for network device discovery and registration. 

See https://amwa-tv.github.io/nmos/ for technical information.

Documentation
PDFs of AJA hardware and software manuals are also installed (by default) at the 
following computer location:

Mac - Applications / AJA Utilities / Docs

AJA Hardware Firmware Update
After the AJA Software Package has been installed on a computer with your AJA 
hardware  installed, the firmware on that AJA device can be updated if a newer 
version of firmware is included with that software package. 

1. Open the AJA Control Panel application.

2. If more than one AJA device is connected, choose the device you want to 
update by selecting its name from the drop-down menu at the top of the 
screen.

3. Go to the AJA Control Panel Firmware Screen.

4. Select the firmware version (if multiple versions exist) in the Desired 
dropdown.

5. Click on Install. Messages appear and when finished, firmware update 
completed messages are shown. 

6. Click Shutdown to power down the computer.

7. Restart the computer. 

8. Open AJA Control Panel. The AJA hardware with the updated firmware 
should be recognized by the Control Panel application. 

Getting Started
NOTE: On first use, you will need to tell your operating system to use AJA hardware as 

the default Audio Input and Output device.

https://amwa-tv.github.io/nmos
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Mac OS System Preferences
For Mac go to System Preferences > Sound > and select AJA Device for both Input 
and Output.

Figure 1.  Mac System Preferences, Sound

Apple Applications
In most cases, using AJA hardware with Apple applications is set and forget. 
Simply set your NLE or other application to point at AJA hardware for all input 
and output operations and that’s it. No need to switch drivers, switch to desktop 
audio, etc. 
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Chapter 3 – Using Final Cut Pro X
Besides non-linear video editing, Final Cut Pro X offers the following capabilities 
that apply to using compatible AJA hardware.

• Play and view video on professional displays connected to your AJA hardware.
• Play, listen to, and record audio through your AJA hardware.

NOTE: Final Cut Pro X does not support video capture or record to tape. The AJA 
Control Room application (free download from the AJA website) provides that 
functionality.

System Configuration Requirements
NOTE: For system configurations required for AJA products, refer to the AJA 

documentation for your specific AJA device available on the AJA website. For 
system requirements for using Apple Final Cut Pro X, refer to the Apple website. 

FCP X Quick Start System Configuration
1. Set your Mac's System Preferences > Sound to the AJA hardware (see "Mac 

OS System Preferences" on page 9).

2. Go to your Applications folder, locate AJA Control Panel, and then run it.

Figure 2.  Mac Applications Folder

3. Go to the AJA Control Panel Control Tab.
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Figure 3.  AJA Control Panel Control Screen (not externally controlled)

NOTE: If FCP X is open and the Window > AV Output setting is checked, the AJA Control 
Panel application will be controlled by FCP X (indicated with red text in upper 
right corner of the window) and you will not be able to configure some Control 
Panel settings. Either uncheck the AV Output setting, or close FCP X to make the 
following AJA Control Panel adjustments.

4. Go to the AJA Control Panel Format Tab.
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Figure 4.  AJA Control Panel Format Screen (not externally controlled)

5. Set the format and frame rate for the output format/frame rate you'd like to 
obtain from FCP X. 

6. Other AJA Control Panel settings that may be involved include:
• Format screen: Follow Input checkbox
• SDI Out screen: SDI output settings
• HDMI screen: HDMI output settings
• HDR screen: High Dynamic Range output settings

NOTE: See the AJA Installation and Operation Guide for your AJA device for detailed 
information. 

7. If necessary, launch Final Cut Pro X, go to the Final Cut Pro X pull-down 
menu and select Preferences.

Figure 5.  Final Cut Pro X Preferences Dropdown

8. Locate the A/V Playout menu in Playback Preferences and confirm that A/V 
Output reports the AJA hardware. 
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Figure 6.  Final Cut Pro X Preferences Playback Window

9. Go to the FCP X Window drop-down menu and click on A/V Output to 
select it. The video output from Final Cut Pro X and the AJA hardware 
should now appear on a baseband connected broadcast monitor. You may 
need to first scrub over a clip to see the video. 

Figure 7.  Final Cut Pro X Window, A/V Output Setting

10. The AJA Control Panel application will report In use by FCPX and will now 
be controlled by Final Cut Pro X.
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Figure 8.  AJA Control Panel Format Screen (Controlled by FCP X)

11. If you need to change the AJA hardware's video output format, turn off A/V 
Output in FCP X, change the settings in AJA Control Panel, and then turn 
A/V Output back on.

For ease of use and clarity about the selected video output format and frame rate, 
you may keep the AJA Control Panel application open when working with Final 
Cut Pro X. 

Final Cut Pro X Audio Configurations
An FCP X session can be configured for audio in different ways. Which method 
you use depends on the audio task at hand, the AJA hardware's audio capabilities, 
and the audio sources to be used.

• AJA hardware audio setup provides optimum A/V sync output using AJA 
hardware for input and output, including zero latency voice-over recording. 
Use this method if your AJA hardware supports your audio sources.

• Because AJA hardware products are Core Audio compliant, they can also be 
used with the Mac's internal audio system for input and output. For example, 
some AJA hardware devices (KONA LHi, KONA LHe Plus, Io XT, Io Express) may 
need to use the Mac's internal audio system for voice-over. However, audio 
sync is not guaranteed when using this method. 

AJA Hardware Audio Mixer Voice-over Setup
If your AJA hardware supports the Audio Mixer feature, you can use one of the 
AJA hardware audio inputs (selected in AJA Control Panel) to add an ultra-low 
latency voice-over track to your project timeline.
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For example, when using the AJA Io 4K Plus, FCP X Voiceover Record can 
make use of Analog Audio In (DB25 Line Level), embedded HDMI Audio In, or 
embedded SDI Audio In. On the Avid Artist | DNxIV there is additional support for 
an Analog Mic input via the front panel (Line, Mic, Phantom 48V).

NOTE: The Avid Artist DNxIV built-in mic pre has a +40 db max output gain. You may 
want to use an external mixer, especially if using a dynamic mic.

Audio Configuration

Recommended settings for FCP X when using KONA 4, Io 4K, Io 4K Plus, and Avid | 
Artist DNxIV for Voice-over with AJA Desktop Software v14.0 and higher are:

NOTE: The following procedure assumes the Mac System Preferences Sound is set to use 
the AJA device for both input and output (see "Mac OS System Preferences" on 
page 9), and that the AJA Control Panel and your FCP X session are configured 
properly for video (see "FCP X Quick Start System Configuration" on page 10).

1. In FCP X go to Window > Record Voiceover and ensure the input is 
AJA Device, and Monitor is Off. Other settings on this screen depend on 
your individual voice-over workflow.

Figure 9.  Final Cut Pro X, Record Voiceover Window

2. In AJA Control Panel, go to Audio Mixer Screen/Playback Monitor, check AJA 
Input, Item Select the input device, and adjust source gain for monitoring. 
This AJA Control Panel screen is active even while being controlled by an 
external application.
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Figure 10.  AJA Control Panel Audio Mixer Screen

NOTE: Adjustments to the monitoring levels or mix does NOT affect any audio being 
recorded into the timeline.

These settings simultaneously provide FCP X Voiceover Record with full-duplex 
zero latency monitoring and capture to the timeline. 

Voice-over Setup Without Control Panel Audio Mixer
KONA LHi, KONA LHe Plus, Io XT, and Io Express do not support the Control Panel 
Audio Mixer. You can use one of the these device's audio inputs (selected on the 
AJA Control Panel) to add a voice-over track to your project timeline. For example, 
if your device supports analog audio input your source could be a microphone 
connected to an audio mixer, with the line-level mixer output connected to a 
KONA/Io breakout panel audio input.

NOTE: This method should not be used when precise A/V sync is required on the output. 
A slight, measurable, delay may be induced.

1. Use the configuration setting described in "Audio Configuration" on page 
15, except for Step 2 on page 15 you use your external audio hardware 
to control your audio record and monitoring levels (these AJA devices do 
not support the AJA Control Panel Audio Mixer).

These settings provide voice-over record (monitoring) on the timeline, but exact 
A/V sync is not guaranteed. 

USB Device Audio Voice-over Setup
If you wish to use a USB mic or computer audio source, you can use the Mac's 
internal audio system for voice-over.

NOTE: The Mac internal audio system voice-over should not be used when precise A/V 
sync is required on the output. A slight delay may be induced.
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The example settings below are intended for use with a USB headset Mic and 
headphones (Logitech headset, for example) to perform a voice-over recording.

• Set the Mac System Preferences  > Sound to the Logitech Headset for input 
and output. 

• In FCP X go to Window > Record Voiceover and ensure the input is Logitech, 
and Monitor is Off. Other settings on this screen depend on your individual 
voice-over workflow.

These settings provide voice-over record (monitoring) on the timeline captured, 
but exact A/V sync is not guaranteed. 

IMPORTANT:   When finished with the voice-over recording, return the Mac System 
Preferences to use AJA hardware, to ensure the remainder of your work in the 
session has the proper A/V sync. 

Importing Clips for Use in Final Cut Pro X
Importing existing clips using FCP X is simple. The same procedure is used 
regardless of the type of AJA hardware. 

1. In FCP X, go to File > Import Media 

Figure 11.  Final Cut Pro X Import Media Selection

2. Navigate to the location of the clip(s) to be imported (multiple files can be 
selected for import).

Figure 12.  Final Cut Pro X Import Media Screen
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3. If desired, set import parameters on the right side of the pane (Figure 12 on 
page 17), including:
• Select into which Event the clip will be added.
• Select Copy to library or Leave files in place.
• Keywords
• Audio Roles
• Transcoding
• Analyze and Fix

NOTE: Refer to Apple's Final Cut Pro X documentation for detailed information.

4. Click Import Selected on the lower right corner of the pane (Figure 12 on 
page 17).

5. The clip is added to the chosen FCP X Event and will be available to be 
added to the FCP X timeline of that Project. 

Capturing Clips for Use in Final Cut Pro X
Final Cut Pro X does not support direct video capture. The AJA Control Room 
application operating in conjunction with the AJA Control Panel application 
provides video and audio capture functionality. 

Once you have captured a clip, it can be imported into the FCP X session as 
described above.

NOTE: Refer to the AJA Control Room Installation and Operation Guide for more 
complete information.

AJA Control Room Clip Capture Quick Start
1. Connect the video and audio inputs and outputs to the AJA hardware.

2. If you wish to use RS-422 control with a playback device, connect a DB-9 
cable between the device and the AJA hardware and enable RS-422 control 
on the playback device.

3. Either close FCP X, or uncheck the A/V Output parameter to ensure the AJA 
Control Panel application will not be controlled. 

NOTE: Only one application at a time should be set to control AJA Control Panel.

4. Open AJA Control Panel and go to the AJA Control Panel Format Tab.
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Figure 13.  AJA Control Panel Format Screen (not externally controlled)

5. Select Follow Input to automatically match the capture settings to the 
input. 

6. In AJA Control Panel, depending on your AJA hardware, configure the audio 
setting as required. See "Final Cut Pro X Audio Configurations" on page 14 
for more information. 

7. Other AJA Control Panel settings that may be, involved for video conversion 
and audio routing, depending on your AJA hardware, may include:
• Format screen: Secondary Format settings
• Input Select screen: Video and Audio Input settings
• SDI Out screen: SDI output settings
• HDMI screen: HDMI output settings
• HDMI HDR screen: High Dynamic Range HDMI output settings
• Audio Setup screen settings

NOTE: See the AJA Installation and Operation Guide for your AJA device for detailed 
information. 

8. Run the AJA Control Room application and click on the Capture tab. 
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Figure 14.  AJA Control Room Capture Screen

9. Ensure the AJA Device is selected in the Device Drop-down menu at the top 
of the screen.

Figure 15.  AJA Control Room, AJA Device Selected

10. Open Control Room Preferences > Capture and Choose the capture path.

Figure 16.  AJA Control Room Preferences, Capture Path

11. Enter the File Name for the clip to be captured, and any other desired 
information.
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Figure 17.  AJA Control Room, Capture Clip File Name Entered

12. If you wish you can reassign the audio channels with the Audio Level Meters 
on the lower right of the screen.

NOTE: See the AJA Control Room Installation and Operation Manual for  more 
information.

13. Prepare the live action, or cue up the source playback device (either locally 
or using the transport controls in AJA Control Room).

14. Click on the red Record button to start the capture, click on the Record 
button again to stop the capture. A red box outlining the display indicates a 
recording is in progress.

15. Close AJA Control Room and reopen Final Cut Pro X, or reselect the A/V 
Output parameter.

16. The captured clip is saved to the specified location, and can be imported 
into a FCP X Project using the procedure described earlier.
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Chapter 4 – AJA Hardware as Audio Interface
AJA hardware is CoreAudio compliant, so it can be used with any application that 
supports Core Audio, including many Digital Audio Workstations. 

Mac Core Audio Configuration
1. Install the AJA Desktop Software Package on the computer you will be 

using. See "Installing AJA Software" on page 7.

2. Go to Apple > System Preferences > Audio and select the AJA hardware 
to be used by default for audio input and output. See "Mac OS System 
Preferences" on page 9.

In many cases when an Apple application is running on your Mac, it will 
automatically recognize and use the AJA hardware when that hardware is 
connected to the computer.

However, other settings may be required, depending on your use case and Apple 
application. 

Using AJA Hardware Audio Input and Output
AJA hardware can be used as an audio interface in various ways, depending 
on the audio task at hand, the AJA hardware's audio capabilities, and the audio 
sources to be used. 

In general, when using AJA hardware as an audio interface:
• Audio input levels that are recorded to a DAW timeline are controlled with 

an external audio mixer. The AJA Control Panel application is used to select 
which signal will be recorded, but not the level of that signal. One exception is 
the Avid Artist DNxIV, which supports a microphone input with a front panel 
gain control.

NOTE: The Avid Artist DNxIV built-in mic pre has a +40 db max output gain. You may 
want to use an external mixer, especially if using a dynamic mic.

• If your AJA hardware supports the AJA Control Panel's Audio Mixer you can 
mix and adjust audio monitoring levels sent to an AJA hardware headphone 
jack or monitor output. These monitor mix and level adjustments do NOT 
affect the audio being recorded to the DAW timeline. 

• If you AJA hardware doesn't support the AJA Control Panel's Audio Mixer you 
will use an external audio mixer for both DAW timeline recording levels and 
monitoring. 
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SOFTWARE LICENSE AGREEMENT
AJA VIDEO SYSTEMS, INC.

THIS IS AN AGREEMENT BETWEEN YOU AND AJA VIDEO SYSTEMS, INC. (“AJA”) THAT 
GOVERNS YOUR USE OF the software ACCOMPANYING THIS LICENSE (E.G., AS installed 
on the device with which this license is provided).  

The “AJA Software” referenced in this Agreement includes all such software, whether 
made available to you on disk, in read only memory, on any other media or in any 
other form, and all updates, corrections, enhancements and new versions of such 
software made available by AJA, together with all related documentation.  BY 
INSTALLING OR USING THE AJA SOFTWARE, YOU ARE AGREEING TO BE BOUND BY 
THE TERMS OF THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS 
AGREEMENT, DO NOT INSTALL OR USE IT AND, IF APPLICABLE, RETURN THE AJA 
SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT FOR A REFUND.

 1.  License Grant. AJA hereby grants you a nonexclusive, personal, non-
sublicenseable and limited license to install and use AJA Software on a computer or 
AJA device. The foregoing license also includes the right to make copies of the AJA 
Software in machine-readable form for installation and backup purposes only, and 
provided that each copy you make must include all copyright or other proprietary 
notices contained on the original.  

 2.  Limitations. You may not decompile, reverse engineer, disassemble, 
modify, or create derivative works of the AJA Software or any part thereof except 
to the extent (if any) authorized by applicable law notwithstanding the foregoing 
restriction. You may not rent, lease, lend, loan, distribute or act as a service bureau or 
“cloud service” provider with respect to use of the AJA Software or any functionality 
thereof. THE AJA SOFTWARE IS NOT INTENDED FOR USE IN THE OPERATION OF 
NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR 
TRAFFIC CONTROL SYSTEMS, LIFE SUPPORT MACHINES OR OTHER EQUIPMENT IN 
WHICH THE FAILURE OF THE AJA SOFTWARE COULD LEAD TO DEATH, PERSONAL 
INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE.   

 3.  Reservation of Rights.  The AJA Software is protected by law, including 
without limitation copyright law.  The AJA Software is licensed, not sold, to you.  AJA 
and its licensors reserve all rights not expressly granted to you by this Agreement.  
You own the media on which the AJA Software is recorded but AJA and/or AJA's 
licensor(s) retain ownership of the AJA Software itself.  You may not use the AJA 
Software for any illegal purpose. 

 4.  Transfer. You may make a one-time permanent transfer of all of your 
license rights to the AJA Software to another person or entity, provided that: (a) you 
transfer all of the AJA Software, including all its component parts, original media, 
printed materials and this Agreement; (b) you do not retain any copies of the AJA 
Software, including any copies stored on a computer or other device; and (c) you 
transfer the AJA Software subject to this Agreement, and the person or entity 
receiving the AJA Software accepts the terms and conditions of this Agreement.  

 5.  NFR (Not for Resale) Copies and Add-On Features: Notwithstanding 
anything to the contrary in this Agreement, (a) AJA Software that is labeled “Not for 
Resale” or otherwise provided to you on a promotional or demonstration basis may 
be used only for your demonstration, testing and evaluation purposes and may not be 
resold or transferred; and (b) AJA may make available certain software components 
(“Add-On Features”) under separate terms and conditions, in which case those 
separate terms and conditions apply and the Add-On Features are not considered AJA 
Software under this Agreement.

 6.  Termination.  Your rights in the AJA Software are conditioned on 
complying with this Agreement, and those rights (together with this Agreement) 
will terminate automatically, without notice from AJA, if you fail to comply with any 
term(s) of this Agreement. Upon termination of this Agreement, you must cease all 
use of the AJA Software and destroy all copies, full or partial, of the AJA Software in 
your possession or control.
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 7.  Limited Warranty on AJA Software.  If you comply with all terms of this 
Agreement and use the AJA Software in accordance with its documentation, and 
you install any patches or other updates made available to the AJA Software by AJA, 
AJA warrants that the AJA Software will perform substantially in accordance with its 
documentation for a period of ninety (90) days from the date of your original retail 
purchase.  Your exclusive remedy under this warranty will be, at AJA’s option, a refund 
of the purchase price of the product containing the AJA Software or an update to 
or replacement of the AJA Software (or applicable component of it).  THIS LIMITED 
WARRANTY AND ANY IMPLIED WARRANTIES ON THE AJA SOFTWARE INCLUDING, 
BUT NOT LIMITED TO, ANY WARRANTIES OF MERCHANTABILITY, OF SATISFACTORY 
QUALITY, OR OF FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION 
TO NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE.  SOME 
JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG A WARRANTY LASTS, 
SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.  THIS LIMITED WARRANTY GIVES 
YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY 
BY JURISDICTION.

 8.  Disclaimer of Other Warranties on Aja Software.  EXCEPT FOR THE 
LIMITED WARRANTY ON AJA SOFTWARE SET FORTH ABOVE, AJA AND AJA'S 
LICENSORS (COLLECTIVELY REFERRED TO AS "AJA" FOR THE PURPOSES OF SECTIONS 8 
AND 9) HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH RESPECT TO THE 
AJA SOFTWARE, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, 
OF SATISFACTORY QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, 
AND OF QUIET ENJOYMENT.  FURTHER, AJA DOES NOT MAKE ANY WARRANTY 
REGARDING NON-INFRINGEMENT OF THIRD PARTY RIGHTS.  SUBJECT ONLY TO THE 
LIMITED WARRANTY SET FORTH IN SECTION 7, YOU EXPRESSLY ACKNOWLEDGE 
AND AGREE THAT USE OF THE AJA SOFTWARE IS AT YOUR SOLE RISK. AJA DOES NOT 
WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE AJA SOFTWARE, 
THAT THE AJA SOFTWARE WILL MEET YOUR REQUIREMENTS, THAT THE OPERATION 
OF THE AJA SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS 
IN THE AJA SOFTWARE WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION 
OR ADVICE GIVEN BY AJA OR AN AJA AUTHORIZED REPRESENTATIVE WILL CREATE 
A WARRANTY.  SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES OR LIMITATIONS ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, 
SO SOME OR ALL OF THE TERMS OF THIS PARAGRAPH MAY NOT APPLY TO YOU.

 9.  Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY LAW, 
IN NO EVENT WILL AJA BE LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, 
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR LOST PROFITS WHATSOEVER, 
INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF DATA, BUSINESS 
INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES OR LOSSES, ARISING 
OUT OF OR RELATED TO YOUR USE OR INABILITY TO USE THE AJA SOFTWARE, 
HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY (E.G., WHETHER 
UNDER CONTRACT, TORT OR OTHERWISE) AND EVEN IF AJA HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. In no event will AJA's total liability to you for 
all damages (INCLUDING WITHOUT LIMITATION BREACH OF WARRANTY) exceed 
the amount of fifty dollars ($50.00).  The foregoing limitations will apply even if 
the any remedy set forth in this agreement fails of its essential purpose.  SOME 
JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, 
OR OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO SOME OR ALL OF THE TERMS 
OF THIS PARAGRAPH MAY NOT APPLY TO YOU.  

 10.  Export Law Assurances.  You may not use or otherwise export or 
reexport the AJA Software except as authorized by United States law and the laws of 
the jurisdiction in which the AJA Software was obtained.  In particular, but without 
limitation, the AJA Software may not be exported or re-exported (a) into (or to a 
national or resident of) any U.S. embargoed countries, or (b) to anyone on the U.S. 
Treasury Department's list of Specially Designated Nationals or the U.S. Department 
of Commerce Denied Persons List or Entity List or any similar legal designation.  By 
using the AJA Software, you represent and warrant that you are not located in, under 
control of, or a national or resident of any such country or on any such list.
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 11.  Government End Users. The AJA Software including its documentation 
is a "Commercial Item", as that term is defined at 48 C.F.R. § 2.101, consisting 
of "Commercial Computer Software" and "Commercial Computer Software 
Documentation", as such terms are used in 48 C.F.R. § 12.212 or 48 C.F.R. § 227.7202 (or 
their successors), as applicable.  Consistent with these provisions, the AJA Software 
is licensed to U.S. Government end users (a) only as a Commercial Item and (b) with 
only those rights as are granted to all other end users pursuant to this Agreement.  
Unpublished-rights reserved under the copyright laws of the United States.

 12.  Controlling Law and Severability. This Agreement will be governed 
by and construed in accordance with the laws of the State of California, as applied 
to agreements entered into and to be performed entirely within California between 
California residents. This Agreement will not be governed by the United Nations 
Convention on Contracts for the International Sale of Goods, the application of which 
is expressly excluded. If for any reason a court of competent jurisdiction finds any 
provision, or portion thereof, to be unenforceable, the remainder of this Agreement 
will continue in full force and effect.

 13.  Complete Agreement; Governing Language.  This Agreement 
constitutes the entire agreement between the parties with respect to the use of 
the AJA Software licensed hereunder and supersedes all prior or contemporaneous 
understandings regarding such subject matter. No amendment to or modification of 
this Agreement will be binding unless in writing and signed by AJA. Any translation 
of this Agreement is intended for convenience and to meet local requirements and in 
the event of a dispute between the English and any non-English versions, the English 
version of this Agreement will govern.
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